Introduction to Solid Modeling

Solid modeling is a process of creating 2-D profiles, extruding 3-D volumes, and applying features to create a
part. Having worked through the Basic training tutorials, one should be familiar with many of the solid model-
ing commands in ThinkDesign. However, solid modeling is more than just capturing the shape and dimensions
of a part. It's also important to convey design intent to whomever views the model, even if it's yourself. In this
task we shall move away from introducing commands, and instead, apply them to a "real world" application. We
shall model a three-hole swivel clevis. Starting with a profile, we shall create a solid to which we will add addi-
tional features and details to create a manufacturable part. We suggest you to go through 15 Rules of Solid Mod-
eling article before doing this task.
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1. Step 1: Create the profile

How one models a particular part is just as important as the model itself. The decisions taken while creating the
model will affect any future additions and modifications you (or someone else) will make to the model. There-
fore one should communicate design intent through the model. With this in mind, our first strategic decision will
be to take advantage of the natural symmetry and model only half the part, then mirror it. Often this will save
the amount of work one must do. However, the not so obvious side-effect is that the designer defines the parting
plane of the part. The second choice is to describe sthe basic hape by modeling the U-shape extrusion. We shall
start by creating the first profile.

First sketch a vertical centerline starting from the origin. This will serve as a point of reference to constrain the
profile. For now, do not worry about placement or exact values. In a few moments we shall constrain the profile
to set the size and lock it in place.
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e Start with a New Model file and set the units to Inches.
e Click Insert > Profile > 2D.
* Draw a vertical Two-point Line from the Work Plane Origin.

The length is not that important because it's going to be a reference line, but if you would like, make the
LengthS in.

=/ 2-Point Line [ 3]

@ FPoints

Type Limited - f/

Sequence Muttiple -

Option Polar (P} - Vertical 30 deg

Length 3.0315 in

Use Make Reference to convert the line into reference geometry.

We shall create the U-shaped Profile with the open end facing down.

» Sketch a Profile of about 1.5in wide and 7in long as shown below.
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e

Create a similar Profile on the other side of the Reference line, with some arbitrary values of length and Width.
Since the profile is Symmetric, we can apply the Symmetric Constraint to complete the Rectangle.
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o
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Apply the Symmetry Constraint between the Curves on the either side of the Reference Line as shown below.
Select the Curves on the left hand side of the Reference line as First Group and Curves on the Right Hand side
as Second Group and Refernce line as the Axis.
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Use Make Reference to convert the Bottom Horizontal lines as Reference Geometry.
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Add geometric constraints to the profile starting with a Ground Constraint.

¢ Add a Ground Constraint to the bottom of the vertical centerline.

* Add a Coincident Constraint between the bottom end point of the reference line and the any one end point
of the Bottom Horizontal Reference line.

Let us add some Dimensions inorder to completely constraint the model.

e Start the Smart Dimension command.
* Add the height and set it to 7 in Measure7 in.
¢ Add the width and set it to 3 in Measure3 in.

* And finally add the height to the Centre Reference line.
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The profile will not be fully constrained because the centerline has one end point that is not constrained. It is not
important that we do so, and it does not matter because we can still create a solid from a partially constrained
profile. That's what we shall do in the next step.

2. Step 2: Today's letter is the letter U

We are now going to take the profile and create a Linear Solid. You might be objecting right now because the
profile is not closed. (Remember, that reference geometry does not add material to a solid.) Again, we have cap-
tured design intent. In this case, the profile describes the inside surface of the U-shaped solid. We want the wall
thickness around the profile to be uniform, and so to create the solid we shall simply "thicken" the wall. You
will see as we create the profile. (Alternatively we could have created a closed profile and then had the flexibil-
ity to individually control the wall thickness.)

Create a Linear Solid from the profile.

+ Start the Linear Solid command

*  Make the Depth 1.5 in. Depthl.5 in

«  Expand ™ More Options.

* Turn on the Thickness and set it to 1 so that the thickness is added to the outside.

« Hit ™I OK



http://thinkcare.think3.com/thinkcare/help2006/english/solids/sl_01/FWfile/T_FW_sl_01_solid.htm
http://thinkcare.think3.com/thinkcare/help2006/english/solids/sl_01/FWfile/T_FW_sl_01_solid.htm
http://thinkcare.think3.com/thinkcare/help2006/english/solids/sl_01/FWfile/T_FW_sl_01_solid.htm
http://thinkcare.think3.com/thinkcare/help2006/english/solids/sl_01/FWfile/T_FW_sl_01_solid.htm
http://thinkcare.think3.com/thinkcare/help2009t1/english/solids/sl_01/FWfile/T_FW_sl_01_solid.htm
http://thinkcare.think3.com/thinkcare/help2009t1/english/solids/sl_01/FWfile/T_FW_sl_01_solid.htm

Introduction to Solid Modeling

- )a Linear Solid K \l_’ " ZJ
& Profie

[z More Options

Direction Normal

Extension Single depth -

Depth 1.5 in

[ Offset Thickness 1 in

Sometimes what we do not do is as important as what we do do. We had the opportunity to add draft to the part,
and it is good practice that we add draft early in the modeling process because, for example, we cannot add draft
to a surface that shares an edge with a fillet. However, adding draft now would affect the ability to add the main
boss because the surface from which the boss will originate will no longer be at a right angle. We shall worry
about that boss later and deal with the secondary bosses in the next step.

3. Step 3: Who's the boss?

Because we are only building half the part, we shall build only half of the two bosses. We have many ways of
doing this. The two natural ways include creating half a cylinder by either sweeping a half-moon cross-section
or to rotate a rectangle around an edge. After either operation, we remove the middle section. Even though the
rotational sweep method is relatively easier, we shall choose the linear sweep method because we want the ra-
dius dimension to appear in a side view drawing. Let's do that first and then we will remove the excess material
in the next step.

We shall need to rotate the Work Plane because we want to create a profile so that the sweep direction is along
the horizontal reference line.

+  Select Edit®Work Plane™ Align to Xand pick the centerline.

+  Select Edit®Work Plane™ Align to Zand pick the horizontal reference line..
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Now create the half-moon profile.

¢ Go to Insert > Profile > 2D.

You probably want to switch to an isometric view to see the snap point more clearly.

+ Create a Center Circle with Radius2 in and make sure to snap to the end point -- Tools>Snap>End
Point-- where the centerline intersects the horizontal reference line.

* Create an Line Given Angle of Angle0 deg and use Snap to Arc Center to snap to the center of the circle.

Constrain the profile.

* Notice that the Point On Curve Constraint between the horizontal line and the arc center is already in
place.
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Now create the Linear Protrusion

» Start Linear Protrusion.

* Pick a side face on the U-shape.

«  Uncheck Thickness and then collapse = More Options if it's expanded
* Right click Depth and select to Symmetric.

+  Then set it to 6 in Depth6 in and click ™ OK.

@ Linear Protrusion LX] Ml :_E_-]
@ Profie

[z Extension Depth -

@ Face

& More Optiuns“”'_“*\

Reuse the boss profile to create an extension.

» Switch to a Wireframe View display mode.
* Select Move/Copy to Current Work Plane

: ?? Mowve/Copy Profile to Current Work Plane [&_‘I [ﬂ ¥
@

» Select the half-moon profile and check the Copy option to duplicate the profile.

* Use the History Tree, and right click the original half-moon profile under the Linear Protrusion and select
Hide Entities

Adjust the size of this new Profile and then create the extension.
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* Double click the new half-moon profile to switch to Profile Mode.
* Change the radius dimension to 1.75.

* Create a Linear Protrusion from this profile similar to the previous protrusion that is 6.25. You may be
prompted to Rebuild Model.

gl Linear Protrusion (3] in) 1)

@ Profile

(= Extension Depth -

@ Face

WMore Options

On to the removal step.

4. Step 4: Sorry, but you're cut from the team

In this step we shall cut-out the material in the middle to reform the U-shape. Now why did not we just create
one boss and then mirror it to the other side and skip the cut operation? With any CAD system, there are limita-
tions. In this case, we already decided before we started modeling that we would use the Mirror Solid com-
mand. What you did not know is that the limitation here is that you cannot mirror a mirrored feature. Remember
what was said earlier. Design and modeling decisions will affect available options later in the modeling process.

Start off by creating the rectangular profile for the cut.

» Right click the Work Plane and Reset to World.
» Switch to a Top View and use Hide Entities to hide the dimensions and profiles.

* Click the Profile tab.
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» Start the Rectangle command and set the Mode to 2 Vertices -- Mode 2 Vertices -- if it is not already.

* Use the Point on Curve Snap, to place each corner of the rectangle so that is lies on the edges of the boss.

EE ] R‘Iec;angle [xj I
[iv} Ipui:nts
Mode 2 Vertices

f PRt S Y size -4 in

X =ize 27603 in

[ Orto Curve|

Add dimensions to the profile.

¢ Start Smart Dimension command.

* Add a 0.25 in dimension between the left edge of the rectangle and the closest inside bottom edge of the U-
shape solid.

* Do the same for the right edge of the rectangle.

Hol

Faols

AEe e e e
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==
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Again we captured design intent. We could have just as easily defined the width of the cut and made it symmet-
ric about the centerline using a width/half-width pair. By dimensioning the extensions instead we guarantee that
no matter how wide the clevis is, the extensions will be 0.25 inches from the inside surface.

Also notice how this particular profile extensively references geometry off the solid. The dimensions reference
edges on the solid. The Point on Curve constraints also reference edges on the solid. In fact, all the profiles so
far, except for the first, reference the solid in some manner. The first profile is the only grounded and indepen-
dent profile. It is a good practice to ground only the first profile, and then reference existing geometry for all
subsequent features and profiles.
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That is enough of a pause. Let's now use the new profile to create the cut.

» Start Linear Slot command.

* Pick the bottom face. It may help to change the display mode to Shaded View and Boundaries
e Turn off the Symmetric option.

¢ In the Selection List, set =" Extension Thru all.

. Hit ¥IOK.

=58 m Linear Slot [_xj M :_i__]
& Profie

= Extension Thru all +

@ Face

[#- MWore Options

Now that we finished the secondary bosses, we shall next create the main boss.

5. Step 5: The big boss

Adding the top boss will be similar to adding the secondary bosses. We shall duplicate the half-moon profile
from Step 3. It is more efficient to reuse existing geometry when possible. However, before we copy the profile,
we should move the work plane to the top of the inside of the U-shape solid.

Unhide the necessary profiles, position the work plane, and then duplicate the half-moon profile.
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» Use Hide Entities to hide the profile used for the slot, and use Unhide Entities to redisplay the first half-
moon profile.

* Double click the inside top surface to move the Work Plane.

* Highlight theWork Plane, right for context menu, and select Move, and snap to the middle of the bottom
edge. Use Tools>Snap~Mid Pointif necessary.

* Ifnecessary, use Edit Work Plane to rotate the Work Plane so that Y points upwards.

+ Use Move/Copy to Current Work Plane to copy the half-moon profile like we did in Step 3.

Reconstrain the new profile.

* Right click the new profile, and select Edit Profile.
* Change the radius to 1.75.
* Puta Collinear Constraint between the line and the bottom edge.

* Next place a Coincident Constraint between the arc center and the centerline end point.

Create the boss feature.

o Start Linear Protrusion command.
*  We want the length of the protrusion to be -3.5. Depth-3.5

« Hit™OK.
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Let's add the final major feature, the outer webbing.

6. Step 6: What a complicated web we weave

The webbing is a feature to reinforce the clevis. It will be a Linear Protrusion. This time we shall add draft at
creation time. The only complicated part will be constraining the profile.

Sketch the profile.

* Change the display mode to Wireframe View, right click the Work plane and click Set to World, switch to a
Top View, and hide all dimensions and profiles except for the first profile.

¢ Click the Profile tab.

* Use Polyline to sketch the shape similar to the one below. Do not snap to anything just yet.
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Add a coincident constraint as shown in the image below to lock the profile to the solid.

* Next add Coincident Constraint between the top inside corners of the profile and the top inside corners of
the solid. Be certain to pick the corner that's part of the bottom surface of the solid so rotate the view as
needed.

- @, Coincidence Constraint | 3¢

]

Type Coincidence
il I

Sequence Single -

Add the remaining geometric constraints to control the shape.

Finally add Point On Curve Constraint between the angled edges and the corners formed by the intersection
between the secondary boss and U-shaped solid. NOTE: if the Profile looks skewed or crooked, just drag one of
the vertical lines to return it to a better shape.
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2J__ Point on Curve Constraint [xj
@ curve
&

Sequence Single ~

trﬁ%

)

Add dimensional constrains.

e Use the Smart Dimension command to add the over all width of 6.5.
¢ Follow that with a half dimension of 3.25 in. Remember to use the centerline.
* Define the overall height to be 9.5 in.

* Then all that is left is to define the distance from the top to the middle corner which is 4 in.

&.5

- B

e

=

CaHo

|
|
|
|
:
! ——l—x

3.25

Create the web feature.

e Start Linear Protrusion command.

*  Pick the bottom face
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* Set Depth-0.675 in.
+  Expand © More Options, then set Angle2 deg. Invert if necessary.
+ Hit M OK.

& ﬁ Linear Protrusion [_xj M [_!J
& Profie

(=) Extension Depth - [
& Face ~

= More Options el
Direction Normal
[ Fillet/Chamfer

Depth 0675 in

[ Offset
V\-\.

Angle 2 deg

£ E—

[ Thickness ..

Now we are ready to add draft to the rest of the part.

7. Step 7: You've been drafted

Draft will allow the tool to eject the part from the mold more easily. However, we will not add draft to all the
side surfaces. We want to keep some surfaces at a right angle, namely the boss surfaces. This is because those
surfaces will mate to another part. The plan is to have those surfaces machined in post-processing.

Add draft to the non-mating surfaces that are perpendicular to the parting plane.

» Start the Draft Angle command.
+ Select the bottom face as the @ Reference Plane

+  For the ® Face selection, pick the side surfaces around the part that are orthogonal to the @ Reference Plane.
Ignore both faces of the secondary bosses and the top face of the main boss.
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» Set the angle to -2 deg. Angle-2 deg The negative sign points the angle inward.

« Hit ™ OK.
= @ onade (X M) (L)
Type Neutral Plane )//

@@ Reference Plane i/

o Faces / r
O Different Angles :

The angle is slight but if we were to zoom in, we would notice the difference. Had we applied draft before we
created the main boss, the boss would be pointed at a 2 degree angle below the horizontal. We would not want
that. Next we will add fillets.

8. Step 8: As he rounds the corners...

Now that we have drafted all the surfaces we want to draft, we can add fillets to the part. The order in which we
apply these fillets is very important. Many of these edges are joined at sharp corners. We will apply the fillets in
a order such that we create a series of tangent edges.

Fillet the major corners.

o Start Edge Fillet command.

* For the first group, create a 1.25 fillet at each top corner of the webbing.
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- (@ EdeeFilet (3] ) L1

= Group 1 Constant radius -
e

®- Group Options
e

[#- Group 2 Constant radius
s

e

*  Click Group 2 from the Selection List, and create a 0.5 fillet at each top inside corner of the U-shape feature.
- @ edeeFilet () W) L1J

[#- Group 1 Constant radius ~

-+ Group 2 Constant radius -
i =

* And for the last group, click Group 3 and create a 2 fillet at each outside middle corner of the webbing.
o EdgeFilet (€] W7 L1J
[®-- Group 1 Constant radius
[®-+ Group 2 Constant radius
=)~ Group 3 Constant radius -

&
T sy -
o Edges(Radiuz=2 [

v
[ Group Optinn37
;

[®-- Group 4 Constant radius
&~ More Optiuns//(;” T

« HitLL Apply.

Next add fillets to the bosses.

» First select the top edges of the secondary bosses.
* Next pick the edges where the extensions meet the secondary bosses.
* Set Radius0.12 in

* Create a new group in the Selection List, and add a 0.05 fillet to the edge at the end of the main boss.
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« HitLL] Apply.
@ Edge Filet () v L1

= Group 1 Constant radius Radius 0.05 in

@

[#- Group Options
—

4
(’ F
- Group 2 Constant radius —+ ¢

£

o

Move on to the next set of fillets.

You do not have to hit LI Apply all the time when making these fillets. If you want to stop and admire your
work, click %1 OK to exit the fillet command. You can always start again!

» Fillet the edges shown on both sides. Notice how the edges chain. This is a direct result of the fillets we
added at the beginning. NOTE: If the edges do not chain, expand ® More Options and check Tangency
Chain.

¢ Set Radius0.1 in

« Hit L1 Apply
= @ Edoe Filet (€ W2 (1D

= Group 1 Constant radius -

& Group Optiens /’}:‘_‘E\'“u'-a

i

Py

Now fillet the pair of edges in between the previous edges. We could not fillet these edges until we filleted the
ones before hand. Otherwise the blend where the webbing meets the secondary boss would have been bad.

« Fillet the edges shown on both sides.

« HitLL Apply since the radius is still 0.125.
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- ¢ Edge Filet () N (L1
I=+ Group 1 Constant radiuz

- Group Options
-

#- Group 2 Constant radius
- R

[#-- More Options

Now fillet the edges where the main boss intersects the U-shape feature.

+ Fillet the edges shown on both sides. Again notice how the edges chain as a result of the previous set of fil-
lets.

« HitLL] Apply.
- (@ EdoeFiet (€] W (L1

= Group 1 Constant radius

& Group Options
& Group 2 Constant radius
-

[#- More Options

Fillet the inner top edge.

» Fillet the edges shown. See how it chains over the main boss now because of the previous fillet operation.

« HitLL Apply
- (@ EdeeFiet () W7 (L1
= Group 1 Constant radius

[#- Group Options
[#- Group 2 Constant radius -

&
- More Optinns_
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Fillet the edges where the secondary bosses intersect the U-shape feature.

» Fillet the edges shown. Again it chains properly.

+ HitMOK.
- @ easeriet () 8 (1D
= Group 1 Constant radiuz - .

@

o
& Group Options
4

& Group 2 Constant radius ~
it

&~ More Options
1 g,

Radius 0,125 in

We finished half the part. Remember that the order that we add features determines the result. It's time to mirror
it and then join with the copy to create one solid.

9. Step 9: Mirror, mirror on the wall

In this step we shall mirror the completed half-clevis. The parting edge will be very apparent. However since the
Mirror Solid command creates a new separate solid, we have to use the Union command to get one single solid
again.

First mirror the solid.

* Reselect the solid (window around it or select it from the History Tree).

¢ Start Mirror Solid command.

Click the bottom face of the part for the @ Face prompt.

. Hit MIOK.

22


http://thinkcare.think3.com/thinkcare/help2006/english/features/FWfile/T_FW_ft_14.htm
http://thinkcare.think3.com/thinkcare/help2006/english/features/FWfile/T_FW_ft_14.htm
http://thinkcare.think3.com/thinkcare/help2006/english/features/FWfile/T_FW_ft_14.htm
http://thinkcare.think3.com/thinkcare/help2006/english/features/FWfile/T_FW_ft_14.htm

Introduction to Solid Modeling

= gl Mirror Solid (€] (W) (L1
&) Base Entiies /: i
: P
= First Symmetry Plane On Fa g
.

0 Face

Now join the two solids together.

¢ Start Solid Union command.

¢ Select both solids.

+ HitM OK

= g® solid union () 8% L1 :
Boolean Giobal _"
@

O Keep Original Solids

We are on the homestretch now. We only need to add the holes.

10. Step 10: Adding top boss and holes

For this final step we shall add the holes to the bosses and then add a single chamfer to the main boss hole. You
might be wondering why we waited until after the Mirror Solid feature to add these holes. The reason is be-
cause where we placed the parting plane makes the holes an undercut feature. The holes are going to be drilled
as a post-process, anyway. By making the holes last, all the toolmaker needs to do (assuming he/she uses
ThinkDesign, too) is to simply delete or deactivate those features, and then there is no undercut. That's the bene-
fit of carefully planning how to model a part.
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Add a hole to the secondary bosses.

« Start Hole command.

*  Click the outside face of a secondary boss.

» Drag the center point to the circumference of the face to snap to the arc center.
* Set Diameter2 in

« HitLL] Apply.
5 §Hoe 00 0 (I
@ Face
= Type Point -
& Point
[ For screw

Hole type: Simple -

Extenszion Thru all -
[#- More Options

Diameter 2 in

Add a hole to the main boss.

*  Click the top face of the main boss.
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» Drag the center point to the circumference of the face to snap to the arc center.
» Set the Extension to Thru Next since we only want the hole to go up to the next face.

+ Hit M OK.
- §roe 3 8 1D
o Face

=~ Type Point -

& Point

O For screw

=+ Hole type: Simple -
Extension Thru next -

[#- More Options

Diameter 2 in

Finally add a chamfer to the top of the main boss hole.

« Start Edge Chamfer command.
* Pick the hole edge at the top.
* Set Distance0.05 in.

- Hit M OK.
= (@ Edge chamfer (3] ) L1J ____.,.—-/"’
=k i

- Group 1 Distance+45* +

' _al
[~ Group Options
el

- Group 2 Distan DBMS“ -
o

-

Clean-up the Graphics Area and that's the end of this task. You should now understand the importance of plan-
ning your modeling strategy, how decisions early in the process impact decisions later on, and why you must en-
deavor to communicate your design intent by the decisions you make during that process. Now that you know
that solid modeling is more than just capturing the shape of your part, you are on your way to becoming a better
designer. :-)
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